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Abstract 

Regarding to the research that deals with Translation from English into Arabic 

there is set of features which determines Quality of translation. Firstly, 

Translation Quality Assessment with its aspects Accuracy, Readability, 

Acceptability, then the research tackles the level of Translations namely raw, 

normal, extra, adaptation of original text. The researcher had mentioned what 

qualified translation and exemplified those steps that hold paramount 

importance. Translation in the research is on reading of Microsoft word 

translation into Arabic and translation problems that may face readers in this 

sense. Starting by disclosing readers of research with history ''evolution'' of 

Microsoft, to compare between older version and nowadays issue. In addition to 

an attempt to provide an annotation to important features in this application 

also, discuss option that helps reader to gain better comprehension of certain 

text, which is Typo and Grammatical error detection. 

Keywords: translation quality, Microsoft Word, translation quality assessment  

  ستخلص�الم

فبخصوص��ذا�البحث�ف�و�ترجمة�من��نجل��ية�للعر�ية�لمايكروسوفت�و���أكناف�الدراسة��ذا�تم�تطرق�للعوامل�

جمة�ال����عتمد�ع���ثلاثة�عوامل����اس��ل�البحث�بمناقشة�جودة�ال�� �ا��و�ر�ة�ال���تتحكم����تقييم�جودة�ال��جمة،

الملائمة�ا��ضار�ة،� قابلية�القراءة،�الدقة�واستحسان�ال��جمة�وخاض�الباحث����مستو�ات�ال��جمة�ال���صنفت��التا��:

�ال��جمة�ا��رفية �التواصلية، �بالعر�ية�ال��جمة �وورد �مايكروسوفت ����ة �شملت ��نا �فال��جمة ��بداعية. ،�ال��جمة

المشا�ل�ال���قد�تواجھ�القارئ�العر�ي����ف�م�المع��.�فتناول�البحث�ا��انب�التار����و���المراحل�ال���مر�عل��ا�و�عض�

يفوت�تذك���القارئ�بتواجد�خاصية��ال��نامج�بالإضافة�لتعر�ج�ع����عض�خصائص�الوورد�وشرح�ا�بطر�قة�م�سطة�ولا 

  أجلاء�وأو��.ال����س�م��ش�ل�أسا�������تحصيل�ف�م�للتدقيق�اللغوي�

  جودة�ال��جمة،�مايكروسوفت�وورد،�تقييم�جودة�ال��جمة.��لمات�مفتاحية:
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 Statement of the Problem:  

Nowadays, most people are turnout to learning languages because of the 

development of technology and exchanging knowledge between nations. 

In addition, people are learning languages owing to the work for instance: working 

in foreign companies, but acquiring and being competent in a language cannot 

ignore the role and the need to the translator and translation. 

Assessing the quality of translation needs three aspects which are: accuracy, 

acceptability, and readability; these aspects are shown clearly in the terminology 

of Microsoft Word in both languages because of the majority of terms are 

scientific, consequently the translation of Microsoft Word from English into 

Arabic is accurate, acceptable, and readable. 

This study is oriented to compare and evaluate the quality of translation between 

English and Arabic on Microsoft Word version 2016 as an example of study. 

Literature Review 

Most topics of dissertations, theses, papers, and others are different from each 

other owing to the variety of research problems and science development; for 

instance: in medical field there are a lot of subfields such as neurology, 

ophthalmology, physiology, among others, except; if there is any additional 

progress in the topic it may the research be repeated, or there may a similarity in 

the topic as research methodology. Often, translation researches based on 

theoretical or literature studies such as theories of translation, the issue of 

translating poem. Therefore, this research cannot be shared with other topics 

because this research looks to revise the translation and terminology of Microsoft 

Word.  
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Research Question 

This research investigates this following research question: 

- To what extent Microsoft Word translation into Arabic serves the Arab 

audience appropriately. 

This main question is divided into the following sub-questions: 

-  Can the Arab user of MS Word understand its terminology easily? 

- Can MS Word have some mistakes despite of its professionalism? 

Hypothesis 

After several endeavor in order to answer the questions of this research, the 

hypotheses may be as follows: 

- The assumption that maybe MS Word had achieved the purpose of issuing 

symmetrical version of English MS Word in Arabic version 

Objective of the study  

This research aims to assess the quality of translation from English into Arabic on 

MS Word version 2016. This research is conducted to explain some difficult terms 

on Microsoft Word in order to facilitate the use of those terms, and clarifying 

many tips may use on Microsoft Word such as: keyboard shortcuts. 

Structure of the study  

This study is made of two parts; theoretical and practical. The theoretical part is 

made of two chapters the first is entitled translation quality, the second is entitled 

Microsoft Word. The practical part is made of one chapter, in an attempt to 

analyze patterns and examples from MS Word both English and Arabic versions. 

The practical part contains an introduction, definition of corpus, and analyses. 

The research methodology that applied in this dissertation is qualitative research; 

the patterns are analyzed by case study and content analysis methodology.    
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This research has an introduction and conclusion that sum up the results of this 

research. Also, at the end of the dissertation there is a summary الدراسة�  ,م��ص

explain the whole work from the theoretical part till the end of analysis. 

Limitation of the study 

The aim of this study is to verify the quality of translation on Microsoft Word; 

because it is a researchable topic. Thus, there are no references in the practical 

part unlike the theoretical part that needs some references. It is difficult if we do 

not say never to deduct a mistake or an error in terminology of Microsoft Word 

such as breaks. The reason of lack of mistakes on Microsoft Word is the 

professionalism of the program that it is a worldwide application.                                                                                                                          
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Theoretical part  

Chapter 01: Translation Quality 

Introduction   
Achieving the coherence in translation is something very difficult that needs 

qualified translators and revisers to get a parallel-translated text, regarding to the 

client creed, religion, and culture measurements. 

Any translation should take into consideration the denotative and connotative 

meaning, nuances, correct grammar, spelling mistakes …etc. Consequently, 

getting a fluent and coherent translated text without any distortion, therefore the 

reader feels the target text TT as it the original text. 

1. Definition of translation 
Translation first appeared as science was in 1964 by Eugene Nida. Then, in 1965, 

John Carry Catford suggested translation as a theory. In 1971 in Canada Montreal 

George Goffin suggested “la traductologie” as a name of science, after that James 

Holmes present a paper in 1972 and proposed translation studies but descriptively. 

In 1973, Brain Harris took the idea of James Holmes but he presented it in a paper 

in the name of transladology referring to John Carry Catford suggestion “la 

traductologie” and this was because of jealousness. In 1988 most of theorist of 

translation accredited translation studies as an official name of science. 

Briefly, translation it is a process of converting texts or speech from one into 

another. The main goal of translation is to render the meaning of the message 

correctly without any distortion that may affect on the meaning in both source 

language SL and target language TL negatively. The translator must be careful 

while translating or interpreting the text or speech to the terminology, nuances, 

grammar mistakes, spelling mistakes, especially in literal translation rather than 

interpreting; in order to get a coherent and parallel-translated text in both source 

text ST and target text TT.   
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2. Definition of translation quality  
Translation quality it is an assessment and evaluation to any type of translation; 

in order to review it to get a coherent and correct translated text. Translation 

quality it is a process of checking the degree of formality, correctness and 

faithfulness for both source text ST and target text TL. Translation quality 

emphasis on three aspects in evaluating a translation; which are: Accuracy, 

Acceptability, and Readability.                                                                                          

3. Aspects of translation quality 
According to (Nababan, Nuraeni and Sumardiono, 2012) the assessment of 

translation quality considers three aspects, which are Accuracy, Acceptability, 

and Readability. 

3.1 Accuracy 
Accuracy can be classified at three degrees which are; Accurate, less accurate, 

and Inaccurate, in order to evaluate the perfection of the translated text from the 

source language SL into the target language TL. 

Accuracy it is an important step in translating texts, because it shows the linguistic 

abilities of the translator.  

Accurate degree aims to render the meaning of the source text ST into the target 

text TT word by word; consequently, to avoid any distortion in the translated text. 

In less accurate degree, the translated text may contain some mistakes that cannot 

change the exact meaning, for instance: spelling mistakes, grammar mistakes. 

This translation can be acceptable. 

Inaccurate text means that the translated text fully wrong because of the 

nonqualified translators. This translation will be refused.   

3.2 Acceptability 
Acceptability it looks for the reader feeling; which means the reader will read the 

translated text as it the original text regarding to the target language culture and 

principles of the society. 
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3.3 Readability 
Readability is how easily written materials can be read and understood; this       

means the translator should simplify him/her language toward the reader by using 

simple and clear words or terminology, also the translator should avoid syntax 

complexities in order to the text be meaningful, clear, and understandable. 

4 Levels of translation quality 
     Translation quality has four levels that can be named and described as follows: 

4.1 Raw translation quality 
Raw translation quality TQ aims to transmit the general meaning of the 

original text. In raw translation quality TQ there may be grammatical and 

spelling mistakes, but finally the text will be understandable. This level 

includes the translation of scientific abstracts. 

4.2 Normal quality translation 
Normal quality translation aims to convey the meaning fluently and 

grammatically correct. Sometimes the source text ST is difficult to translate 

because of the terminology. Generally, this level includes the translation of 

technical texts. 

4.3 Extra-quality translation 
Extra-quality translation aims to transfer the meaning of the original text 

fluently and idiomatically correct, regarding to the culture measurements of 

the target text TT. Often, this level includes the translation of literature. 

4.4 Adaptation of original text 
Adaptation of original text does not look for the direct translation, but more 

than this; it attempts for adapting the source text ST to the target text TT 

culturally and idiomatically. The translator sometimes can omit or add 

something according to target language standards; in order to get a coherent 

and fluent translated text.  
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5 Translation quality assurance TQA 
Translation quality assurance TQA it is a process of reviewing the translation 

aiming to ensure the quality of the translated text. In translation quality 

assurance TQA, there are many steps to verify the quality of the translated text 

such as reviewing, editing translations, checking for grammatical errors, 

ensuring consistency in terminology usage, and verifying the accuracy of 

cultural references. Also, translation quality assurance TQA it has a set of 

stages among of them: translation review and terminology management. 

5.1 Translation review 
“ It refers to the process of checking a translation in order to detect and correct 

errors, omission, and inconsistencies, as well as to improve its quality, clarity, 

and relevance to the target audience” (przybysz&sini,2017); this shows the 

importance of reviewing any translation to approve or decline it in order to be 

present with the client expectations. 

5.2 Terminology management 
Terminology management it asks for the use of the words or terms; that the 

translator selected in the target language TL, attempting to facilitate the 

readability for the client. 

6 Quality control 
Quality control it is a stage in translation quality assurance TQA; which is the 

final step in translation process because it works to check and scan the 

translated text sentence by sentence and word by word, in order to evaluate the 

whole translation by verifying any mistakes for instance: grammar mistakes, 

spelling mistakes. Quality control it has five steps that can help the reviewer 

to control and assess the quality of the translated text. 

6.1 Review and correction 
A professional translator or reviser must review the translated text to ensure 

that the translated text does not has any errors or typos. 
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6.2 Formatting and layout check  
This step it applies to ensure that the translated text is rendered perfectly, 

therefore the reader will understand the translated text easily. 

6.3 Terminology and style check 

In this step, the translator should select the correct terminology and style, in 

order to assure that the translated text is clear, readable, and understandable 

for the target reader. 

6.4 Cultural adaptation 
This means the translator must meet the source text ST to the target text TT 

culturally; such as: idiomatic expressions, aiming to get a coherent and 

appropriate translation in both source text ST and target text TT; in the object 

of the target audience understand the translation. 

6.5 Final approval 
Final approval means that the client will approve the translated text; which 

means the reader can understand it, because this step it looks for the final 

delivery in order to meet the client expectations. 

7 The role and principles of effective and efficient quality control 
During assessing and controlling quality, the managers are taking into 

consideration the consequences of any probable mistakes or errors made by 

the translator; and this mistake or error may be happened because of the 

nonqualified translators, workload, time pressure, and others. 

This shows the importance and the necessity of selecting qualified and 

competent translators, for instance: each translator has his/her domain of 

competence. 

In addition, translators and revisers have their individual strengths and 

weaknesses such as accuracy, domain of competence. These competences and 

the expertise of the translator  will be taken into account in order to enrich the 

profile or CV to be selected as the best translator or reviser by the client.        
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8 Translation quality assessment TQA 
Translation quality assessment TQA it is a subfield of translation studies that 

works to signal any faults in the translated text. Translation quality assessment 

TQA it is a process that aims to evaluate and assess the translation. It uses to 

check the quality of the translated text by reviewing it if there are any mistakes 

or mistranslations, as well as to achieve the attempted level of readability, 

acceptability, and accuracy. 

8.1 Translation quality assessment models TQA 
Waddington is one of the major scholars of translation quality assessment 

TQA; proposes four models that named Method A, Method B, Method C, and 

Method D. Method A and B are error analysis, Method C is a holistic method 

of assessment, and Method D is a combination of B and C. 

 Method A  

Errors are divided into three categories 

A- Inappropriate renderings that affect the source text’s understanding, may 

be classified into eight categories: countersense, faux sense, nonsense, 

addition, omission, unresolved extra linguistic references, loss of meaning, 

and inappropriate linguistic variation (e.g.: language register, style and 

dialect) 

B- Inappropriate renderings, which affect target language TL expression. 

These are divided into five categories: spelling, grammar, lexical items, 

text, and style 

C- Inadequate renderings that affect the transmission of either the main 

function or secondary function of the source text ST. 
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 Method B  

Method B is also focus on error analysis and was designed to consider the 

negative effect of errors on the overall quality of the translations. The corrector 

has to determine whether each mistake is a translation mistake or just a 

language mistake; this is done by deciding whether or not the mistake affects 

the transfer of the meaning from the source text into the target text: if does not, 

it is a language error, if it does, it is a translation error. 

 Method C 

This Method it attempts to evaluate the whole translation, taking into 

consideration the fluency, cohesion, and quality in general. The corrector    in 

This Method should follow three aspects, which are the accuracy of rendering 

from the source language SL into target language TL, the quality of the 

terminology that selected in TL, and the degree of task completion.  

 Method D 

Method D includes a combination of error analysis Method B and holistic 

Method C in a proportion of 70/30; this means Method B accounts for 70% of 

the total result and Method C for the remaining 30%. 

8.2 American Translator’s Association ATA framework 

ATA framework it is a translation quality assessment model used by the 

American Translator’s Association; that aims to graduate a qualified and 

certified translator, this can be by the ATA framework that attempts to evaluate 

and assess the trainee’s translations by a test made by the ATA. 

8.3 Text type of translation quality assessment TQA  
In translation quality assessment, there are two main types of texts, which are: 

literary texts and industry texts. Most of translators prefer literary texts such 

as poetry, drama, novels...etc, because this type of texts in their point of view 
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seems easy to translate due to the lack of obligations (free translation) for 

instance: specific terminology.                                                                                 

In the other hand, the industry translation it works with the technical fields 

(any specified text); such as: legal translation, medical translation, political 

translation…etc. The translator in industry translation may face some 

difficulties in translating texts because of the sensitivity of the topics; this is 

why nonqualified translators avoid industry translations.    

    Conclusion 
Translation it is a key factor in exchanging knowledge between people and 

acculturation, because it is the first step to communicate with others. For this 

reason, any translation must be understandable and clear for the reader in order 

to facilitate the communication between people in different languages.    

Any translation should be reviewed by a competent and qualified revisers or 

translators to assess the quality of the translated text, hence; the translation to 

be readable, acceptable, and accurate, in the aim of to meet the reader or client 

necessities and expectations. Therefore, the translator must pay attention to 

his/her translation especially in adapting texts and linguistic nuances to 

produce a perfect translation as Norman Shapiro said: translation can only be 

felt by a scratch in the glass. 
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Chapter2: Microsoft Word  

Introduction 
Microsoft Word is a program used to process documents and typing texts in 

different languages. Microsoft Word Issued versions since 1983 also it has several 

features as fonts, adding also bold & italics. 

As word have pros it might have cons such as reading through different Microsoft 

Word languages (Arabic-English) Taking into consideration those two are 

contrast to one another. In this paper discussion is regarding, to what extent MS 

Word translation Arabic serves the Arab audience appropriately. 

1. Microsoft History   
Microsoft give birth to "Multi-tool Word" in 1983 and was known widely; Word 

1.0. By two programmers whom Charles Simonyi & Richard Brodie. Those were 

recruited by Bill Gates and Paul Allen in 1981. In that era word was solely 

dedicated to operate on computers supported by Unix Operating system. 

Word was What You See Is What You Get Program. In Other word printed 

document is duplicate of your word; not to mention that word grants its users with 

various options such: creating, saving, also printing. 

Version 2.0 saw the light in 1985 with new updates namely word count, spelling 

check, within a few years Microsoft updated numerous times to operate on Disk 

Operating System and Macintosh. Name was shortened from Multi-tool Word to 

Word. 

In 1993 Microsoft merged word 6.0, and this was the final version under that 

nomination .Compatible with Macintosh, Windows, also Disk operating System, 

and the latter one does not support up comings Word .Following issue was named 

after years of issuing .After that Microsoft pace of issuing was lasting in most of 

times two years for each version among latest release was the end of 2018, with 

word 2019. 
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2. Microsoft Word  
Microsoft word is program within package of Microsoft office suite. 

Predominantly used to enter, edit, format, save, retrieve and print documents. 

MS Word also known as Word and better recognized Microsoft word is word 

processor, released by Microsoft. Microsoft word is a program within others of 

Microsoft office suite; despite that it can be purchased itself alone. 

By now Microsoft Word is celebrating 41 years. It has witnessed a lot of 

betterment; for now, it is on market of apple’s and windows users. 

Microsoft Word was not the prominent word processor due to its unfamiliar 

design unlike WordPerfect the most used at that time. In spite of that Microsoft 

undertake a list of updates namely 1985 version which can operate on Macintosh; 

and on 1987 managed upgrading important features. Not to mention a brand 

functionality of Support rich text format (RTF). 

Moreover, Microsoft Word has embedded dictionary for spell checking and 

misspelled words are noted in a red squiggly underline. Microsoft Word grants 

users with text-level features such as bold, underline, italic; and page-level 

features such as indentation, paragraphing. 

In 2007, docx became the ordinary file format, instead of “.doc” extension. 

Microsoft Word renewed, also Microsoft operating systems. Because of intra- 

relationship of Microsoft Office suite with the Microsoft operating system, its use 

featured in user frustrations around end-of-life for Microsoft XP and the 

successive Vista and Windows 7, 8 and 10. 

Meanwhile, Microsoft was getting on the cloud bandwagon. Its new offering, 

Microsoft Office 365, out-taking old also single machine licensing methods with 

a cloud-delivered set of software applications that users can access from any given 

time. 

 Many customers are now accessing Microsoft Word and Office suites through 

office 365 instead of buying it by downloading it with license keys. Typically, the 

cloud-delivered a method that allows for different use on multiple devices. Even 

though some users failed to gain new devices authorized, another frequent aspect 
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of the cloud-delivered software is that there is no necessity to download it onto 

the local hard drive. Additionally, Microsoft has launched multiple, helpful, and 

complementary cloud application such as OneNote, OneDrive and SharePoint for 

enterprise users, and a mobile Office suite for Apple and Android. 

3.  Word Keyboard shortcuts 
Shortcuts indicates to easiest and fastest method, way, technique to achieve 

objectives. It can be ostensible for instance road between two places that reduce 

distances or keystrokes. With Keystrokes time and power is preserved and led to 

smart work. 

As Mentioned by U. C-Abel Books( 2016) To access various functions quickly in 

Microsoft Word, use keyboard shortcuts: 

Open a document: Ctrl+O 

Create a new document: Ctrl+N 

Save the document: Ctrl+S 

Close the document: Ctrl+W 

Select all: Ctrl+A 

Bold: Ctrl+B 

Copy: Ctrl+C 

Change character formatting: Ctrl+D 

Align center: Ctrl+E 

Find: Ctrl+F 

Go to: Ctrl+G 

Additionally, there are more advanced shortcuts like: 

Switch to outline view: Ctrl + Alt + O 

Switch to print view: Ctrl + Alt + P 

Toggle between normal and split mode: Ctrl + Alt + S 

You can also customize keyboard shortcuts in Word by following these steps: 

Press ALT+F, T to open the Word Options dialog box. 

Press the DOWN ARROW to select Customize Ribbon. 



 

27 
 

These shortcuts can help improve your efficiency when working in Microsoft 

Word. 

To insert a table in Microsoft Word, use this shortcut: 

Insert a table: Alt + N, then press T. 

This shortcut allows you to quickly create a table in Word without having to 

navigate through the menu options. 

With that being said there is always commands that ordinary users can benefit 

from them by knowing hands-on shortcuts .Exploring keyboard shortcuts in that 

user can starts query of getting to know new shortcuts by well-known websites 

namely Zapier and GCF Global . 

4. Features of Microsoft Word  
 Alignment: Lines situation in body of text according to document left and right 

margins. 

 Bold: Letters in bold are used for stressing; i.e. bold word differs from 

regulars' ones. 

 Indentation: The space to be left from the page margin that is used upon 

paragraph or body of text. 

 Insertion Point: Definition to that terminology lay within it; place of text 

insertion, also the place of flashing cursor. 

 Bullets: Characters used to enumerate a given part of text. 

 Margin: Go to ribbon then choose layout to find margins; void space left on page. 

Normally estimated by inches. 

 Insert Picture: Go to ribbon then choose insert to find pictures, which are images 

can be included in The Document. 

 Italics: Italicized letters shaped on monitor leaning on right. And to use italics 

click on home choose to italicize your text. 

 Format Painter: Is an option of copying formatting of one word or paragraph, 

and project it on another counterpart. 

 Font: In Microsoft there is multiway of typeface namely: Times New Roman, 

Arial Black, Arial also freestyle script. Font includes. 
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 Print Review: Provide insight to what document looks once printed. 

 

a) Home Tab 

1) Clip board: Choose the text to be copied. Reach for Home Tab then click on 

Clipboard Box  

2) Copy: Permit to maintain Original text while transfer it elsewhere. 

3) Cut: Will displaced the original text and place it elsewhere. 

4) Paste: This option to insert whatever has been copied. 

 Centering: Is when writing on the middle of the page where the left-most and 

right-most characters distanced symmetrically with left and right margins. 

  

b) Insert Hyperlink: This option allows the user of Microsoft word to put 

another part it can be website, other document; within the document. By 

following this: 

Select the text want to be changed into hyperlink  

o Click on the Insert tab in Word  

o Click on the Link button in the toolbar 

o Choose "Existing File or Web Page" if linking to an external site or 

document 

o Enter the URL or select the file wish to be linked to 

o Click OK to save the hyperlink. 

a) Design: Shows a list of effects and enables the user to opt for the 

appropriate one. 

Styles: templates have applied various consistent font, font size, font color, and 

spacing to headings, paragraphs, and titling throughout the document. 

Selecting words, paragraph, list or table to edit. 

On the Home tab, select a style. 
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If the user wants to see more options, click the More button to expand the gallery. 

Themes: Add unique appearance to the document  

Select Design then click on Themes. 

Pick on a theme to preview how it will look. 

The user Select the theme. 

b) Layouts: The user can alter layout in Microsoft Word, by modifying 

various elements in according to its needs. From this element there is 

orientation, margins, and page size. 

Page Orientation: 

Select the Layout tab, then click on Orientation. 

Choose between Portrait or Landscape orientation 

Margins: 

Click on Layout, then select Margins. 

Choose from predefined margin sizes or set Custom Margins to a customize one.  

Page Size: 

By default, a new document is set to 8.5 inches by 11 inches. 

User can adjust the page size in the Page Setup dialog box under the Layout tab 

Section Breaks: 

Use section breaks to change the layout or formatting within specific sections of 

your document. 
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Insert section breaks to make formatting changes like starting new chapters or 

creating different layouts on the same page 

These steps allow user to tailor document's layout to suit your specific needs in 

Microsoft Word. 

5. Terminology of Microsoft Word 
 Terminology Functions 

1 Quick Access toolbar 
Shortcut to usual (Commands) 

2 File Tab 

File Tab took place in 2007 which 

considered backstage. In that you can get 

access Microsoft options namely Info, 

New, open, save, save as, print, share, 

export, close, account, options. 

3 Ribbon Tab 

Any ribbon is categorized; due to his 

function. 

4 Ribbon 
Provided a relative order; within tabs. 

Each of which offers button for command. 

5 Group 
Contain category of command buttons.  

 

6 Show Dialogue box 
Give other choices to users. 
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6. Typo and Grammatical error detection 
When working in a file, your Office app checks for spelling and basic grammar 

mistakes. Word autocorrects many mistakes and if it's not autocorrected, a 

detection will appear as a squiggly line under the misspelled words and a double 

underlined detection for grammar mistakes. Right-click the underlined word to 

see a suggested list of corrections, Select the word and opt for change in your file. 

Select Review > Spelling & Grammar or press F7 to review spelling and grammar 

all at once. 

As stated by Stewart Melart (2015) In Word, the Editor pane opens. Use a 

suggested word, select it or click the dropdown arrow, and then select Change All 

to fix every time this word appears in the file. Other options include Add to 

Dictionary ,Office remember this spelling across all apps in the future  or Ignore 

Once or Ignore All, if the word is already correct .Select Change All for now .The 

spelling and grammar checker is similar across all apps ,then this is the right tools 

to present your best work possible. 

I. Fix spelling and grammar  

II. Right-click text with a squiggly line or a double underline underneath. 

III. Select the correct spelling from the list of suggestions. 

A. Check the entire file 

B. Select Review > Spelling & Grammar or press F7. 

C. In the Editor pane, select the correct spelling from the list of suggestions. 

D. Select Change All to fix every time this word appears in your file. 

i. Other Options 

a. Add to Dictionary: Office remember this spelling across all apps in 

the future. 

b. Ignore Once: To ignore the mistake and remove the squiggly line 

or double underline. 

c. Ignore All: To ignore the mistakes and remove the squiggly line or 

double underline for all instances of this text in the file. 
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     Conclusion  
In conducting this research upon Microsoft Word and as an observation of 

researcher to conclude that it operates on all systems including Windows and 

macOS also almost all application support Microsoft Word i.e.: iOS, android, 

and web version. That is what helps to carry on this research and macadamize 

this path. 

Problems faced in Microsoft word can be rectified with the help of specialties 

or scientific studies related to this issue. Microsoft Word is very helpful in 

preparing correspondence notably in administration at levels of schools, 

universities. In order to achieve that the user needs hands on annotations, that 

facilitates and enhance comprehending of Microsoft Word. That where 

translation takes place of linking interfaces and simplifies the matter to all 

readers. 
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Practical part 

Introduction 
Any program or application should have multilanguage to facilitate the  

access to its users and simplify it by translating the terms in several languages.  

Translation it is a widespread process in the world because it looks to facilitate 

the communication and acculturation between people over the world. 

As an example of translation and its importance, Microsoft Word has many 

languages on; it that can help anyone to access his/her duty easily, and this was 

others. Microsoft Word gives the opportunity to anyone to write in any language 

by downloading it. Also, Word offers the process of corresponding, sharing and 

this can be by several languages such as: Arabic, English, French, and others. 

1. Definition of corpus    

Within a long period, Microsoft Word has maintained to exist as the head of 

processing programs. The updating to application simplified writing and the 

creation enriching documents. Word is a member of Microsoft Office suite and 

its grants users to work jointly with colleagues even in distances. Word generate 

productivity and helps you take full advantage of documents. The cutting-edge 

era exists today is largely powered by smart and intelligent software namely 

Word. In this part, discussion is regarding to history of Microsoft Word and how 

it has evolved over the period. In 1981, Xerox programmer, Charles Simony; 

introduced to Microsoft to develop Word. The first issue of productivity software 

launched in 1983. Microsoft Word is an unprecedented application to incorporate 

bold-faced and italic fonts, as well as line breaks. In addition, one of the earliest 

programs to appear on Mac computers. In 1985, version 2 of MS Word which 

included spell check and word count features was released. The first version of 

the application for Windows was released in 1989; two years before WordStar 

and WordPerfect were introduced to the new Windows operating system.        
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2. Analysis  
This study needs qualitative research; in order to verify the quality of translation 

into Arabic. Qualitative research is an approach that aims to address research 

questions that focus on understanding the meanings, experiences, and social 

realities of people in their natural settings. Methods are designed to led towards 

invulnerable understanding of phenomena, also the experiences, beliefs, 

perceptions, and decisions of people. There are several types of qualitative 

research, and in this paper a combination between content analysis and case study 

research. Case study is a research method that involves the testing of knowledge 

regarding to a specific material to attain a better insight of its complexities, 

dynamics, and context. Content analysis involves systematic reading or 

observation of texts or artefacts with assigned labels to indicate interesting content 

involves systematic reading or observation of texts or artefacts. 

Pattern one 

1. Watermark علامة مائیة 
Watermark is a background image or text to be showed in document of Microsoft 

Word, it used to display image, text, for instance: ''name of the author'' or '' do not 

copy'' to document. User can find watermark by opting it in design tab. Watermark 

can be permanent on document, with that users can safeguard his intellectual 

property. Arabic suggested equivalence is علامة مائیة" " and defined as a signature 

or stamp in page of word to protect author copyright, and this term also can refer 

to watermark on banknote, legal document and postcards. In this rendition 

Translator maintain both functional and load of the Original Text and transfer it 

into the Target text faithfully. Type used in this Pattern is Technical Translation 

because terminology used belongs to software Domaine. 

   

 



 

36 
 

 

 

 

 

 



 

37 
 

Pattern two 

2. Breaks فاصل صفحات 
In Microsoft Word there are tools that enable users to modify formatting and 

document structure by separating the content into sections. These breaks allow 

users to adjust formatting between pages, add columns, and change margins. In 

counterpart rendition it is فاصل الصفحات" " and it literally means where the page in 

document should ends or starts, so it is safe to say translation is accurate; due to 

readability and acceptability of the word. 
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Pattern three 

3. Cross-reference اسناد ترافقي/ارتباطات 
Microsoft Word's Cross-reference tool directs readers to other areas of the 

document. It allows you to link to headers, bookmarks, tables, figures, footnotes, 

and other content. This allows readers to quickly and easily navigate to the 

appropriate areas of your paper, assisting them in finding crucial facts in your 

work. Arabic translation " اسناد ترافقي/ارتباطات"   in this Pattern simplicity of the term 

led the readers to comprehend the meaning clearly. Consequently, it is an accurate 

translation. 
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Pattern four  

4. Endnote  الحاشیة السفلیة 
Endnote in Microsoft Word is a function that allows users to insert footnotes and 

endnotes into their pages. Endnotes occur at the end of a document or section, 

whereas footnote appear at the bottom of the same page. Endnote inserts a 

reference mark into the text and places the footnote or endnote mark at the 

specified location. Users can enter footnote or endnote text. Endnote also offers 

customization options for footnotes and endnotes, including adjusting the size, 

font, and indentation. The rendition in counterpart is   " الحاشیة السفلیة"  which is  a 

comment or reference appears at the end of the page usually mentioned with 

symbol or number already given in word page .This translation may be ambiguous 

to the Arabic reader due to complexity of the term itself, in addition to 

interpretation that may took place when first reading the word .The rendition 

suggested here " تذییل الصفحة " 
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Pattern five  

5. Textbox مربع النص 

Particularly, the use of textboxes is an important way to draw attention to specific 

text. Also, it can be helpful when users' needs to move text around in a document, 

Word supports a variety of styles and effects that allow the author to format text 

boxes and the text contained within them. Rendition in Arabic is '' مربع النص'' 

which is an element can be added to contain text, and the user can select the place 

of Textbox according to his/her needs. In this sense rendition suggested in Arabic 

is acceptable, because it describes functional option through the term. The reader 

would not be confused while opting for ''Textbox مربع النص ''    
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Pattern six  

6. Format painter نسخ التنسیق 
Format painter it is an option of copying formatting of one word or paragraph, 

and project it on another counterpart. The Arabic equivalence نسخ التنسیق" " can 

only means copying certain structure of word page to other page, there is no 

ambiguity due to simplicity, and acceptability, to the reader it renders the meaning 

clearly.  
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Pattern seven  

7. Macro الماكرو 
Macro it is an option used to save the format of Word in order to copy and 

paste it in another document. You can find macro by clicking on view then 

click on macro as the arrow shown in the image. Linguistically, the term macro 

is not clear and not understandable for the reader due to the specific software 

usage and the transliteration of the term, here MS word may fail in finding an 

equivalent to macro in Arabic.    
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Pattern eight 

8. Start mail merge بدء دمج المراسلات 
Start mail merge it is a feature uses to correspond with others by inserting an 

email, letters, images, Word document, or sticker. The equivalence in Arabic 

version "بدء دمج المراسلات" ;The term in this pattern preserve syntactic structure 

of Arabic language SVO, semantically the term means to link database or 

letters that already existed in order to create pattern letter or write to invite a 

group of people or organization .MS Word succeed in conveying the meaning 

correctly without any ambiguity in the use of the term. 
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Pattern nine  

9. SmartArt 
SmartArt it is a function used to design a professional scheme. At first level of 

denotative meaning MS Word succeeded in choosing the term SmartArt owing to 

the widespread of using the term smart and art, but; linguistically MS Word failed 

in giving an equivalent to SmartArt even in transliteration. 
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Pattern ten 

10. Layout تخطیط 
Layout it is a feature used to fix margins, size of the page, columns and 

other features. The equvialance provided in Arabic version is ""تخطیط  That 

implies parameters applied on word page such as margins, sizes and so on.  

The translation of this term is accurate because it engendered linguistics 

and semantic meaning without any distortion that may affect on the 

meaning. MS Word gain in conveying the same load and meaning existing 

in SL. 
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Conclusion  

Since translation is the initial step in communicating with others, it plays a crucial 

role in the exchange of knowledge between individuals and in the process of 

acculturation. To improve communication between speakers of various 

languages, translations must be clear and intelligible to the reader. Generally, it is 

rarely to find mistakes in professional programs as Microsoft Word because it is 

a worldwide application that most people, administrators and others use it in 

writing and corresponding. Sometimes the reader may face some difficulties in 

understanding the terms of Microsoft Word; especially for the Arab users who 

may use Microsoft Word in Arabic; these difficulties may be faced because of the 

software terms used in Word for instance: Watermark علامة مائیة.  

The coherence in translation is a process that need competent translators and 

revisers to accomplish a parallel translation, and assistance of experts or relevant 

scientific research that can help resolves issues with Microsoft word, to achieve 

fluency and coherence without distortion ,translations must take into account 

denotative and connotative meaning and subtleties , to do that, the user requires 

interactive annotations that improve and facilitate Microsoft Word 

comprehension. This is when translation replaces interface linking and makes the 

content easier to understand for all readers .Microsoft Word is a tool for 

processing documents and inputting messages in several languages, Microsoft 

Word has been in use since 1983.However it has advantages and disadvantages , 

such requirement to read in dual languages (Arabic-English). In this article 

examination of to which extent MS Word translation into Arabic serves the Arab 

audience effectively. 
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  م��ص�الدراسة

�ول�تناول��بفصل�ن،تمحور�الدراسة�حول�قراءة�ال��جمة�مايكروسوفت�وورد�بالعر�ية��شق��ا�النظري�الذي�ناقش�ت�

بتعر�ف�ال��جمة�وأ�مي��ا�المستمدة��اس��ل�العم��.�فالعملجودة�ال��جمة�و�الثا�ي�مايكروسوفت�وورد�بالإضافة�للفصل�

ال��جمة��ألا�يتخللال�دف�شر�طة��نا�يك�عن�دور�ا����نقل�المع���من�اللغة�المصدر�إ���اللغة�،ببعض�ا���ر�ط�الشعوب�

للنص��صل�أثناء�عملية�ال��جمة�مع�مراعاة��عودةع���غ��ه�أي�ال�مالا�يقعع���عاتق�الم��جم��شائبة.�فيقعأي��شو�ھ�أو�

الم��جم�إ����ص���من�خلال�معا��ة��خطاء��نصالقار�ة�مترجمة�المصط��ات�أيضا�ا��انب�اللغوي�الذي�يتمثل����

�و�ملائي �ل�ي�ةاللغو�ة �المع�� ��� ��والفروقات �المع�� ��� �م�ا�� �نص �ع�� �ا��صول �ف�ذ�والب�يةي�س�� يأخذنا��االلغو�ة.

�جمة�فيمكن��عر�ف�ا�بإ��ا�تحقيق����ال��؟ال��جمةِ الذي�ي�بادر�للذ�ن�ما���جودة���ساؤل الفلكيفية�تقييم�جودة�ال��جمة�

�ذه�السياق�بالضبط����ا��وض����ترجمة�من�أجل��فا��ودة،�و��أدوات�تتمثل����تطابق�وقياس�الدقة��باستعمال

القراءة��وقابليةلثلاثة�عوامل�و���دقة���متثاليجب���ذا،���اللغة�ال�دف�و�طبع�لتحقيق��ومع�� تحصيل�نص�متناسق�

�و�التوا��النص��لاستحسانبالإضافة� ��المنتج. �إ�� �نصنف�ا �أن �ال��جمة�ال����ستطيع �نجد�مستو�ات �جودة أر�عة:��عد

��التواصلية،�ا��ضار�ة،�ال��جمة�الملائمة ��،ا��رفيةال��جمة �فل�لال��جمة ���بداعية. �واستعمالھصنف�م��م�مم��اتھ

جمة�ف���العملية�ا��وض����ال��جمة�بدون�ذكر�أساليب�ال���تمكن�الم��جم�من�تأكد�من�جودة�ال�� �ا��اص.�وليمكننا

من��ال��جمة،�التحقق����المراجعة�التدقيقال���تضفي�ا��ودة�لل��جمة�فتتم�مراجعة�وتحقيق����النص�ال�دف�بواسطة�

فالموافقة�والمصادقة��الثقافية،مع�العناية�بدقة�الفروقات��المصط��ات،�استخداممن�تطابق������ملا�ي،�تأكد�خطاء�

جودة�ال��جمة�أنھ�و����ل�نص�م��جم�قد�ي�ون��ناك�أخطاء�وع��ات�ناتجة�عن���ميةوأدور��المطاف.�وتكمن���أخر�

  م��جم�غ���كفءَ�أو�ز�ادة����زخم�العمل.

����الدراسة�ع����يئة�اتحاد�م��ج���الولايات�المتحدة� �ذه�ال�يئة�قياس�جودة�ال��جمة��فتختص (ATA)وقد�عرجنا

  يجتاز�ا�المت�ون����ال��جمة.��اختبار وتأ�يل�الم��جم�ن�و�تم��ذه�بواسطة�

أد�ي��ما��و تخوض�����ل���دبية�ال���ستخدم�جودة�ال��جمة�لقياس�نوع�ن�ل��جمة�وع���وجھ�ا��صوص�ال��جمة�

أس�ل�لل��جمة�بال�سبة�لبعض�الم��جم�ن���لو�ا�من�المصط��ات�العلمية��اأيضا�القصص�ف����س�ي�والدراما�الشعر   مثل:

ال��جمة�التقنية�ال���يتوجد�ف��ا�أنواع��المع��.�وثانتقييد�يل��م�بھ�الم��جم�عدا�إيصال��يوجدلا�من�ج�ة�ومن�ج�ة�أخرى�

�لارت�ابأيضا�ال��جمة��علامية�و����ذه��صناف�يجد�الم��جم�نفسھ�عرضة��والقانونيةال��جمة�الطبية��مثل:متعددة�

  جب�م��جم�متمكن�ومتمرس����مجالھ.�خطاء�ال���قد�تف����خلل�بالنص�ال�دف�فلذلك��ذه�ال��جمات��ستو 
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اللغات�أول�إصدار�لھ��الوثائق�متعددو���الشق�ثا�ي�من�الدراسة�تم�تناول�مايكروسوفت�وورد�و�و�برنامج�لمعا��ات�

  بخصائص�مم��ة�نذكر�م��ا�حرف�المائل�وا��ط�القاتم.�ي��و�ان���1983ان�سنة�

وع���الس�يل�المثال�لا�ا��صر��ورسوماتالعديد�من�ا��صائص�ال����ساعد����تحر�ر�الكتابة�أو�ا�شاء�جداول��دور للو 

كما�ل��نامج�وورد��عض�وأ�م�ا�ال���محل���جن�ية،�غي���ا��طوط�باللغة�العر�ية�ة��وإم�انيةاختصارات�لوحة�المفاتيح�

ال��نامج�ال���من�شأ��ا�تظ�ر�علامة�استف�ام�للقارئ�العر�ي���ذه�الدراسة����عدم�ف�م��عض�المصط��ات�التقنية�ل�ذا

الورد�باللغة��نجل��ية��المتقابلت�ن،��ك���ع���اللغت�ن�الففي��ذه�الدراسة��ان��.خاصة�ان��ان�ال��نامج�باللغة�العر�ية

  .يمة�القارئ�العر�سؤال�ا��و�ري�إ���أي�مدى�توفقت�ترجمة�الورد�بالعر�ية����خدالونظ��ه�باللغة�العر�ية�ف�ان�

� ���لوحة�المفاتيح�فعوض��اختصاراتفالبحث�تطرق�لبعض�ا��صائص�ال���توجد����مايكروسوفت�وورد�يذكر�م��ا

بالميكروسوفت�فيكفي�المستعمل�فقط�أن�يضغط�ع���لوحة�المفتاح�بطر�قة�معينة��استعمالھالبحث�عن�خاصية�يراد�

م�ان��القاتمةتوفر�مايكروسوفت�وورد�ع���شر�ط��دوات�الذي�يحتوي�ع���خطوط��للطلب.�وأيضا�باختصار فيصل�

����الت�سيق�...�ذكرت��ل�من��ذه�ا��صائص�بتعر�ف�موجز��ا��رف�المائل�الذي�,حرف�المائل,ال��م�ش,إضافة�النص

خط�المائل��ار واختيالصفحة�الرئ�سية��ع���تفعيل�ا��اصية�يكفي�الضغطليظ�ر�ا��رف�مائل�لليم�ن�ع���شاشة�ف

تفعيل��ذه�ا��اصية�يكفي�الذ�اب�لللنص�و�ال��م�ش�ف�و�المساحة�ال���ت��ك�خالية�بجانب�النص�وتقاس�بالإ�ش�ف

نذكر�أيضا�فاصل�الصفحات�الذي��ستعمل�لتغي����,ضغط�ع���تخطيط�ل��صول�ع���ال��م�ش�اللشر�ط��دوات�و 

  ا��اص�لمستعمل�مايكروسوفت�وورد�.��حتياجمع���ستعمالمع��يتلاءمطر�قة��دراج�ل�ي�

ن�يتوجب�ذكر�مصط��ات�ال���تختص���ا�وورد�ودور�تطرق�ل��صائص�الذي��ستحوذ�عل��ا�تطبيق�وورد�ف�� ال�عد�

م��ا�شر�ط�الوصول�السر�ع�الذي�يحول�دون�ا��اجة����البحث�المطول�عن��مر�المراد���عدادات،ال���تقوم�بھ��ذه�

منھ��2007ظ�وره�مع�وورد��و�دأثا�ي�الملف��مباشرة،�مر��فاختيار لشر�ط�الوصول�السر�ع�تنفيذه�يكفي�فقط�توجھ�

  نا�يك�عن�مشاركة�الملف.�والطباعة���وورد�كحفظ�الملف���عداداتيمكن�الولوج���ميع�

تطرق�للتدقيق�اللغوي�لما�يحوز�من�أ�مية�بارزة�����ذه�الدراسة�ع���وجھ�اليمكن�مناقشة����برنامج�الوورد�دون��ولا 

فالعمل��والمس�ندات،�خص�ال���تقوم�ع���قراءة�ترجمة�وورد�بالعر�ية�ف�ذه�ا��اصية�تقوم�ب�نقيح�النصوص�الكتابية�

  لمطلوب.اش�ل�الع���ا��اسوب�صياغة�النص�ب�ما��عذر ع���ت��يح�الملفات�ي�ون��ش�ل�آ���أو�يدوي�إذا�
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ي�اف��ا��وماذكر��عض��وامر����شر�ط��دوات�باللغة��نجل��ية��ع���الطرح�يتمحور أما�عن�الفصل�التطبيقي�ف�ان�

بن�يجة�سوى�ما�المقابل�باللغة��للان��اءتحليل��س�ند�إ���ضوابط�وأسس�علم�ال��جمة��استعراضمع��العر�ية،باللغة�

�فقد�تم����ا��زء�التطبيقي�أخذ�عشرة�أمثلة�كدراسة�حالة�و�ذا�من�خلال�.بذلكالعر�ية�قد�أدى�المع���أو�لم�يوفق�

و�نجل��ية،�كما�تم�الظا�رة����وورد�ب���ت��ا�العر�ية��و�ستخداماتلقطة�شاشة�لبعض�المصط��ات��عض�الصور��

لقيام�بھ.��شرح��ذه�المصط��ات�شرحا�م�سطا�ليب�ن�كيفية�استعمال��ذه�ا��صائص�ل�ي��س�ل�ف�م�العمل�المراد�ا

المستعمل�باللغة��نجل��ية��تب�ن�أن�المصط���المعمقة�و�عد�الدراسة�ف�م�ا،ا��الات�نظرا�لوجود�ل�س������ذه�اخت��ت

؛�حيث�فقدت�يجبأ�سر�للف�م�مقابل�اللغة�العر�ية�ال���فشلت�نوعا�ما����نقل�المع���المطلوب�للقارئ�العر�ي�كما�

�قابلية�القراءة,�استحسان�النص�عض�المصط��ات�لشروط�جودة�ال��جمة� نتائج�دراسة��ذه�و�إم�ان��،و���الدقة,

,�كما�ا��الات�أن��عمم�ع���جميع�برنامج�مايكروسوفت�وورد�لأن�ال��جمة�المستعملة����برنامج�وورد����ترجمة�حرفية

�و�الطبيعة�للغة�العر�ية�ل�ذه�المصط��ات��م�ا��س�ب�صعو�ة�وجود�نّ�أ�يمكن�أن��ستخلص�من�خلال��ذا�العمل

�نجل��ية�ال���استحوذت�ع���مجال�العلوم�و�التقنية�ع���عكس�اللغة�العر�ية�ال���تختص���ا�اللغة��والتقنيةالعلمية�

ال���مازالت�تصارع�لمواكبة�اللغة��نجل��ية؛�و�ذا��و�المراد�ا��قيقي�من�عمل��ذه�المذكرة�ال���تم��ت�بدراسة�برنامج�

  .سوفت�ووردمايكرو عظيم�وعر�ق�ألا�و�و�

��  
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Appendix 01: 

Glossary 
English/ French/ Arabic  
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Glossary  

 Français English  العر�ية

  ضمان�جودة�ال��جمة
L'assurance de la 

qualité du traduction  

Translation quality    

assurance TQA 

  تقييم�جودة�ال��جمة
L'évaluation de qualité 

du traduction 

Translation quality 

assessment TQA 

 Barre d'outils Toolbar  شر�ط�الم�ام

 L'analyse d'erreurs Error analysis  تحليل��خطاء

  جودة�ال��جمة
La qualité de 

traduction 

Translation quality 

 Contrôle de qualité Quality control  مراقبة�ا��ودة

  مراجعة�ال��جمة
La révision de 

traduction 

Translation review 

  إدارة�المصط��ات
Gestion terminologique Terminology 

management  

 Précision Accuracy  الدقة

 L'acceptabilité Acceptability  التقبل

 Lisibilité Readability  المقروئية

 L'adaptation Adaptation  التكييف
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���  Copier Copy 

 Coller Paste  لصق

 Grand Bold  خط�غامق

 Qualité Quality  ا��ودة

 Hyperlien Hyperlink  رابط

 Mise en page Layout  تخطيط

 Horizontale Landscape  أفقي

 

 

 

 

  

 

 

 

 

                                            


